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High inflationary pressure in the U.K. will lead to short-term pressure on Scotland Gas 
Networks PLC and Southern Gas Networks PLC's (together known as SGN) credit metrics. 
With lags in tariff setting and revenues indexation as part of the current regulatory framework, 
we expect temporary pressure for the financial year ended in March 2023 (FY 2023) as 
inflationary pressures feed through the group’s cost base on top of much higher accretion 
amounts (with index-linked debt and derivatives accounting for about 35% of SGN's 
consolidated reported debt).

That said, we believe SGN's credit metrics will remain in line with the current ‘BBB’ rating 
during the current five-yar regulatory period (RIIO-GD2). Our base case assumes inflation 
levels will gradually ease, leading to a recovery in credit metrics as short-term pressures fade, 
while the benefits of revenues indexation to higher inflation will gradually accrue from FY 2024 
onwards. Our forecast is for S&P Global Ratings-adjusted FFO to debt of 5.0%-6.0% in 2023, 
rising to 7%-8% for the rest of RIIO-GD2, ending in FY 2026. 

High inflationary pressure adds to an already challenging financial package for gas 
distribution networks over RIIO-GD2. RIIO-GD2, which has completed its second year, is 
marked by a reduced allowed return compared with the previous regulatory period. The average 
cost of capital was projected to average about 3.2% for both networks as of January 2023 in 
real CPIH (a measure of real consumer price inflation that includes owner-occupiers' housing 
costs) terms, compared with 3.76% in retail price index over RIIO-GD1. 
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Ratings Score Snapshot

Recent Research
• EMEA Utilities Outlook 2023: United Kingdom: Tailwinds For Energy, Cross-Currents For 

Water, Jan. 24, 2023

• Industry Top Trends 2023: EMEA Utilities, Jan. 23, 2023

• Western Europe Regulated Gas Utilities Handbook 2022, Nov. 4, 2022

Company Description
SGN supplies natural gas to 5.9 million customers (about 28% of U.K. gas users) through 75,000 
kilometers of gas mains and services. SGN comprises a holding company, Scotia Gas Networks 
Ltd., a consolidated MidCo group that includes SGN MidCo Ltd., and the two operating 
companies Southern Gas Networks and Scotland Gas Networks, which have a combined 
regulatory asset value of £7 billion as of the end of March 2023. SGN is privately owned by a 
consortium comprising the Ontario Teachers' Pension Plan Board (37.5%), Brookfield (37.5%), 
and Global Infrastructure Partners (25%).

A small part of SGN's operating profit comes from the nonregulated activities of its contracting, 
connections, commercial services, and property operations. SGN's networks in southern 
England stretch from Milton Keynes in south-central England to Dover in the southeast and 
Lyme Regis in the southwest, and include London boroughs to the south of the River Thames. 
The Scottish network covers all of Scotland.

Outlook
The stable outlook reflects our view that SGN will maintain FFO to debt of 6%-8% over 2023-
2026, which is above our 6% trigger for our ratings on the group. The outlook also indicates that 
the group will operate in line with its business plan during RIIO-GD2 and maintain good 
operating performance.

Downside scenario
We could lower the rating if SGN demonstrates weaker operating performance or reduces 
profitability, causing credit metrics to fall below the triggers for the current rating level (i.e., FFO 
to debt falling consistently below 6%).
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Upside scenario
We could upgrade SGN over the medium term if we see a track record of maintaining FFO to 
debt sustainably above 9%, coupled with excellent operational performance. This would likely 
require significant mitigating action implemented by the management team. We would also 
expect to see FOCF to debt at a broadly neutral level.

Key Metrics

Scotland Gas Networks PLC--Forecast summary

Period ending Mar-30-2019 Mar-31-2020 Mar-31-2021 Mar-31-2022 Mar-31-2023 Mar-31-2024 Mar-31-2025 Mar-31-2026

(Mil. GBP) 2019a 2020a 2021a 2022a 2023e 2024f 2025f 2026f

Revenue  1,235  1,262  1,217  1,105 1,200-1,250 1,300-1,350 1,250-1,300 1,325-1,375

EBITDA 717 795 723 569 600-650 700-750 625-675 750-800

Funds from operations (FFO)  459  493  488  304 275-325 400-450 375-425 450-500

Debt  4,704  4,764  4,625  4,791 5,100-5,200 5,200-5,400 5,400-5,600 5,600-5,800

Adjusted ratios         

Debt/EBITDA (x)  6.6  6.0  6.4  8.4 8.0-9.0 7.0-8.0 8.0-9.0 7.0-8.0

FFO/debt (%)  9.8  10.3  10.6  6.3 5.0-6.0 7.5-8.5 6.5-8.0 7.5-9.0

All figures are adjusted by S&P Global Ratings, unless stated as reported. a--Actual. e--Estimate. f--Forecast. .

Financial Summary

Scotland Gas Networks PLC--Financial Summary
Period ending Mar-31-2017 Mar-31-2018 Mar-30-2019 Mar-31-2020 Mar-31-2021 Mar-31-2022

Reporting period 2016a 2017a 2018a 2019a 2020a 2021a

Display currency (mil.) GBP GBP GBP GBP GBP GBP

Revenues 1,125 1,156 1,235 1,262 1,217 1,105 

EBITDA 721 661 717 795 723 569 

Funds from operations (FFO) 444 407 459 493 488 304 

Interest expense 209 175 196 189 166 185 

Cash interest paid 194 155 160 160 156 133 

Operating cash flow (OCF) 406 357 343 458 610 349 

Capital expenditure 381 398 429 408 346 318 

Free operating cash flow (FOCF) 25 (41) (86) 50 264 31 

Discretionary cash flow (DCF) (175) (378) (319) (28) 149 (83)
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Scotland Gas Networks PLC--Financial Summary
Cash and short-term investments 20 381 30 124 289 123 

Gross available cash 20 381 30 124 289 123 

Debt 4,362 4,379 4,704 4,764 4,625 4,791 

Common equity 643 1,024 1,046 1,332 1,456 1,238 

Adjusted ratios       

EBITDA margin (%) 64.1 57.2 58.0 63.0 59.4 51.5 

Return on capital (%) 11.1 9.2 9.4 10.1 8.8 6.1 

EBITDA interest coverage (x) 3.5 3.8 3.7 4.2 4.3 3.1 

FFO cash interest coverage (x) 3.3 3.6 3.9 4.1 4.1 3.3 

Debt/EBITDA (x) 6.1 6.6 6.6 6.0 6.4 8.4 

FFO/debt (%) 10.2 9.3 9.8 10.3 10.6 6.3 

OCF/debt (%) 9.3 8.1 7.3 9.6 13.2 7.3 

FOCF/debt (%) 0.6 (0.9) (1.8) 1.0 5.7 0.7 

DCF/debt (%) (4.0) (8.6) (6.8) (0.6) 3.2 (1.7)

Peer Comparison

Scotland Gas Networks PLC--Peer Comparisons  

 
Scotland Gas 

Networks PLC
Cadent Gas Ltd.

Northern Gas 
Networks Finance 

PLC

Wales & West 
Utilities Finance 

PLC

Foreign currency issuer credit rating BBB/Stable/-- BBB+/Stable/-- BBB+/Stable/-- --

Local currency issuer credit rating BBB/Stable/-- BBB+/Stable/-- BBB+/Stable/-- --

Period Annual Annual Annual Annual

Period ending 2022-03-31 2022-03-31 2022-03-31 2022-03-31

Mil. GBP GBP GBP GBP

Revenue 1,105 1,984 421 452

EBITDA 569 1,089 236 228

Funds from operations (FFO) 304 647 160 79

Interest 185 273 53 72

Cash interest paid 133 188 34 81

Operating cash flow (OCF) 349 770 133 94

Capital expenditure 318 861 165 144

Free operating cash flow (FOCF) 31 (91) (31) (50)

Discretionary cash flow (DCF) (83) (286) (123) (110)

Cash and short-term investments 123 91 7 283

Gross available cash 123 91 7 283

Debt 4,791 8,956 1,649 1,682
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Scotland Gas Networks PLC--Peer Comparisons  
Equity 1,238 3,862 561 (128)

EBITDA margin (%) 51.5 54.9 56.1 50.5

Return on capital (%) 6.1 5.0 6.7 9.0

EBITDA interest coverage (x) 3.1 4.0 4.5 3.2

FFO cash interest coverage (x) 3.3 4.4 5.7 2.0

Debt/EBITDA (x) 8.4 8.2 7.0 7.4

FFO/debt (%) 6.3 7.2 9.7 4.7

OCF/debt (%) 7.3 8.6 8.1 5.6

FOCF/debt (%) 0.7 (1.0) (1.9) (3.0)

DCF/debt (%) (1.7) (3.2) (7.5) (6.5)

Environmental, Social, And Governance

Environmental factors are a moderately negative consideration in our credit rating analysis of 
SGN, as is the case for other regulated gas networks in Europe. This reflects long-term 
uncertainty about the prospects for gas networks. SGN is working on a range of projects that 
seek to demonstrate the viability of hydrogen networks in the U.K., including H100 in Fife, which 
will deliver green hydrogen to about 300 households when completed. These projects will 
support the U.K. government's aims to have 10 gigawatts of hydrogen production capacity by 
2030. SGN's environmental strategy, announced in April 2021, includes a target for all its 
business operations to be net-zero by 2045.

N/A--Not applicable. ESG credit indicators provide additional disclosure and transparency at the entity level and reflect S&P Global Ratings’ 
opinion of the influence that environmental, social, and governance factors have on our credit rating analysis. They are not a sustainability rating 
or an S&P Global Ratings ESG Evaluation. The extent of the influence of these factors is reflected on an alphanumerical 1-5 scale where 1 = 
positive, 2 = neutral, 3 = moderately negative, 4 = negative, and 5 = very negative. For more information, see our commentary “ESG Credit 
Indicators: Definition And Applications,” published Oct. 13, 2021.

- Climate transition risks

ESG Credit Indicators

S-3 S-4 S-5 G-3 G-4 G-5E-5

- N/A - N/A

S-1 G-1S-2 G-2E-1

To view a video tutorial, hold Ctrl and click this box

Visio instructions

1.To select a new score, click on a red box (e.g. E-2), then click 
on Format Painter (Home tab) to copy the color. Next, click on the 
desired score. 

2. To unselect the old score, click a blank score box, click Format 
Painter, and click on the old score to clear it. 

3. Select the red score boxes and click ‘Bring to Front’.

4. Replace the placeholder bullets with the E, S and G factors 
supplied by your analyst, ensuring text formatting remains as it is.

5. Remove any remaining placeholder bullets

6. If no factors are listed in one or two sections, insert: N/A and 
type ‘N/A--Not applicable.’ at the start of the footnote. (If no factors 
are listed in all sections, use the NO FACTORS template instead.)

7. File > Export > Change File Type > PNG

8. In the PNG Output Options window:
-Resolution: set to printer 
-Size: set to custom, pixels, 800 x 275 (see below)

9. Click okto save in Pictures folder.

CAP instructions

1. Place the cursor where you want the graphic to appear and go 
Insert > Pictures > This Device > find image and click ok

2. The image will look very small. Select the image, go to the 
Picture Format tab, change the width to: 5.51 inches / 140mm / 
14cm / 

E-4E-2 E-3
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Rating Component Scores

Foreign currency issuer credit rating BBB/Stable/--

Local currency issuer credit rating BBB/Stable/--

Business risk Excellent

Country risk Low

Industry risk Very Low

Competitive position Excellent

Financial risk Aggressive

Cash flow/leverage Aggressive

Anchor bbb

Diversification/portfolio effect Neutral (no impact)

Capital structure Neutral (no impact)

Financial policy Neutral (no impact)

Liquidity Adequate (no impact)

Management and governance Satisfactory (no impact)

Comparable rating analysis Neutral (no impact)

Stand-alone credit profile bbb

Related Criteria
• Criteria | Corporates | General: Reflecting Subordination Risk In Corporate Issue 

Ratings, March 28, 2018

• General Criteria: Guarantee Criteria, Oct. 21, 2016

• General Criteria: Group Rating Methodology, July 1, 2019

• Criteria | Corporates | General: Corporate Methodology: Ratios And Adjustments, April 1, 2019

• Criteria | Corporates | General: Methodology And Assumptions: Liquidity Descriptors For 
Global Corporate Issuers, Dec. 16, 2014

• Criteria | Corporates | General: The Treatment Of Non-Common Equity Financing In 
Nonfinancial Corporate Entities, April 29, 2014

• General Criteria: Country Risk Assessment Methodology And Assumptions, Nov. 19, 2013

• Criteria | Corporates | Utilities: Key Credit Factors For The Regulated Utilities Industry, Nov. 
19, 2013

• General Criteria: Methodology: Industry Risk, Nov. 19, 2013

• Criteria | Corporates | General: Corporate Methodology, Nov. 19, 2013

• General Criteria: Methodology: Management And Governance Credit Factors For Corporate 
Entities, Nov. 13, 2012

• General Criteria: Principles Of Credit Ratings, Feb. 16, 2011

www.spglobal.com/ratingsdirect June 26, 2023       6

Scotland Gas Networks PLC and Southern Gas Networks PLC



www.spglobal.com/ratingsdirect June 26, 2023       7

Scotland Gas Networks PLC and Southern Gas Networks PLC

STANDARD & POOR’S, S&P and RATINGSDIRECT are registered trademarks of Standard & Poor’s Financial Services LLC.

S&P may receive compensation for its ratings and certain analyses, normally from issuers or underwriters of securities or from obligors. S&P reserves the right
to disseminate its opinions and analyses. S&P's public ratings and analyses are made available on its Web sites, www.standardandpoors.com (free of charge),
and www.ratingsdirect.com (subscription), and may be distributed through other means, including via S&P publications and third-party redistributors.
Additional information about our ratings fees is available at www.standardandpoors.com/usratingsfees.

S&P keeps certain activities of its business units separate from each other in order to preserve the independence and objectivity of their respective activities.
As a result, certain business units of S&P may have information that is not available to other S&P business units. S&P has established policies and procedures
to maintain the confidentiality of certain non-public information received in connection with each analytical process.

To the extent that regulatory authorities allow a rating agency to acknowledge in one jurisdiction a rating issued in another jurisdiction for certain regulatory
purposes, S&P reserves the right to assign, withdraw or suspend such acknowledgment at any time and in its sole discretion. S&P Parties disclaim any duty
whatsoever arising out of the assignment, withdrawal or suspension of an acknowledgment as well as any liability for any damage alleged to have been
suffered on account thereof.

Credit-related and other analyses, including ratings, and statements in the Content are statements of opinion as of the date they are expressed and not
statements of fact. S&P’s opinions, analyses and rating acknowledgment decisions (described below) are not recommendations to purchase, hold, or sell any
securities or to make any investment decisions, and do not address the suitability of any security. S&P assumes no obligation to update the Content following
publication in any form or format. The Content should not be relied on and is not a substitute for the skill, judgment and experience of the user, its
management, employees, advisors and/or clients when making investment and other business decisions. S&P does not act as a fiduciary or an investment
advisor except where registered as such. While S&P has obtained information from sources it believes to be reliable, S&P does not perform an audit and
undertakes no duty of due diligence or independent verification of any information it receives. Rating-related publications may be published for a variety of
reasons that are not necessarily dependent on action by rating committees, including, but not limited to, the publication of a periodic update on a credit
rating and related analyses.

No content (including ratings, credit-related analyses and data, valuations, model, software or other application or output therefrom) or any part thereof
(Content) may be modified, reverse engineered, reproduced or distributed in any form by any means, or stored in a database or retrieval system, without the
prior written permission of Standard & Poor’s Financial Services LLC or its affiliates (collectively, S&P). The Content shall not be used for any unlawful or
unauthorized purposes. S&P and any third-party providers, as well as their directors, officers, shareholders, employees or agents (collectively S&P Parties) do
not guarantee the accuracy, completeness, timeliness or availability of the Content. S&P Parties are not responsible for any errors or omissions (negligent or
otherwise), regardless of the cause, for the results obtained from the use of the Content, or for the security or maintenance of any data input by the user. The
Content is provided on an “as is” basis. S&P PARTIES DISCLAIM ANY AND ALL EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, ANY
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR USE, FREEDOM FROM BUGS, SOFTWARE ERRORS OR DEFECTS, THAT
THE CONTENT’S FUNCTIONING WILL BE UNINTERRUPTED OR THAT THE CONTENT WILL OPERATE WITH ANY SOFTWARE OR HARDWARE CONFIGURATION. In
no event shall S&P Parties be liable to any party for any direct, indirect, incidental, exemplary, compensatory, punitive, special or consequential damages,
costs, expenses, legal fees, or losses (including, without limitation, lost income or lost profits and opportunity costs or losses caused by negligence) in
connection with any use of the Content even if advised of the possibility of such damages.

Copyright © 2023 by Standard & Poor’s Financial Services LLC. All rights reserved.


	Ratings Score Snapshot
	Recent Research
	Company Description
	Outlook
	Downside scenario
	Upside scenario

	Key Metrics
	Financial Summary
	Peer Comparison
	Environmental, Social, And Governance
	Related Criteria

